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This is an extension of chapter 32 in the printed book, “Sharing Traces: Designing and 
Fabricating Your Own Printed Circuit Boards with Fritzing.”  Here we will shift our focus from 
Fritzing, a popular hobbyist/hacker application, to Eagle, one of the “industry standard” 
software packages. 
  
Autodesk’s Eagle is one of the standard EDAs used by professional electronic engineers and 
amateurs alike.   As a hobbyist you can download a free version of Eagle—a Personal Learning 
License for individual and non-commercial use—and students can get an Educational License to 
use Eagle for free. This is a great way of familiarizing yourself with what it can do. Go to 
Autodesk’s website, and under Products you will find Eagle. Under “Overview” the options for 
both licenses will be available to you. Either of these two are good enough for what we will do. 
Take the time to navigate the website, read about it and view what it can do. Installing Eagle is 
easy, just follow the instructions. Once installed, launch it. A pop-up window will ask you to 
sign in. Eagle provides you with two different editors: one for schematics and another for board 
layout. These two spaces are synchronized in real-time. 
 
Eagle’s Control Panel is the first thing you see when the program is launched (figure 28). In the 
Control Panel you have access to the different aspects of a project and Eagle’s configuration. On 
the left you have a list of drop-down menus. These all offer ways of working your project. I will 
explain these as we go.  
 
 

 
Figure 28 Eagle Control Panel 
 
Libraries are a powerful feature of Eagle, and we’ll start by installing SparkFun and Adafruit 
libraries. These will come very handful, because these include standard stock parts from 



Sparkfun and Adafruit projects, such as audio and barrel jacks, potentiometers, common chips, 
and so on.  All you need to do is explained on this step-by-step guide: 
https://www.autodesk.com/products/eagle/blog/library-basics-install-use-sparkfun-adafruit-
libraries-autodesk-eagle/ 
 
Download the libraries from their Github repositories. If Github is new to you, then just click on 
Clone or Download and select Download ZIP. Create a folder in your Documents directory and 
copy/paste the extracted files there. Now go to Eagle’s control panel and on the Options tab, 
select Directories. The first path on the top is for the Libraries. Instead of having 
$HOME/Documents/EAGLE/libraries change the path for 
$HOME/Documents/eagle_external_lbrs and click OK.  
 
Go to the Control Panel and under Libraries the “new external libraries” folder will show up, but 
these have not yet been activated. You’ll notice a gray dot is next to each item in the library. To 
activate the libraries, right click on the library folder, select “Use All”, and all those gray dots are 
now green. SparkFun and Adafruit parts are now available for use in Eagle. As your skills 
develop and projects grow in complexity, you can create your own custom libraries in Eagle.  
 
Now move to the Projects folder at the bottom of the list of the control panel. When opened, two 
subfolders will show: “Projects” and “Examples”. If you are curious and have time, feel free to 
explore the Examples folder, where you will find many references on what Eagle can do. The 
user’s Projects folder will be empty.  
 
Let’s create a new project. It’s good to start by making a new Project folder. Right click on your 
Projects folder, select New Folder and name it as you please. I will call mine HEM_PCBs. Now 
right click the new folder and select New Project. Name it however you want; mine will be 
called Synth4584-001. Notice that next to your Project there is a green dot, which indicates the 
currently active project. The dot for every other project will be gray and slightly smaller.  
 
Schematic 
 
Right click on your new Project, go to New and select Schematic (figure 29).  (In Eagle you do 
your design work in schematic form, rather than on a virtual breadboard, as we did in Fritzing; 
this might make the process more difficult for beginners, but has the long-term advantage of 
making it easier to import circuit designs from the rest of the world).  The Schematic Editor 
window will open (figure 30). In this editor you can work out the logical representation of your 
project. On the left is the toolbar with all the different commands. From the top downwards, you 
will see many other features, including a command line right before the white working 
surface.  The little cross on that surface is the origin, point 0, 0. It is not moveable.  



 
Figure 29 New Project window 
 

 
Figure 30 Schematic editor 
 
On the top-left you will see a little grid (figure 31). Click on it and a new pop-up menu will open. 
Where it says Display, select On and then click OK (figure 32). Your working surface now looks 
like graph paper. This is very important because everything you do will snap to that grid even if 
the display is off. By default, the spacing of the grid is 0.1 inch and it is strongly recommended 
to use that default settings: everything in the schematic editor is spaced at tenths of an inch and, 
since everything snaps to the grid, you can confirm that each connection was made successfully. 
An even finer grid will be available if you press the alt key, but my advice is to limit its use only 
for graphics or notes but not for the actual schematic.  
 



 
Figure 31 Grid 
 

 
Figure 32 Display Grid 
 
Let’s start putting things together. On the toolbar there is something that looks like an AC power 
plug with a green + symbol (my guess is that it is a symbol for an AND Gate) (figure 33). If you 
hover your cursor on top it will say “add part”. Click it. This is how you get access to all the 
parts libraries that come with Eagle. In here you will find pretty much everything you might 
need; if not, new libraries can be made and/or installed (as we did at the start of our Eagle 
tutorial) (figure 34). You access these through the Control Panel’s Libraries dropdown menu 
(figure 35). The important thing to know is that Eagle’s part library’s search bar cuts no slack to 
anybody: it will look for exactly what you type. This can be frustrating and can lead you to think 
that none of the parts that you need are available on Eagle. Because of that, Eagle allows the user 



to include wildcard characters as part of the search, including the question mark (?) and the 
asterisk (*).  The question mark is for just one character and the asterisk for any number of 
characters. Sometimes, for example, integrated circuits come will all sort of prefixes and suffixes 
which are hard to remember. When you look for just the digits that you remember, nothing 
shows up even though it might be the standard name of the part. In that case wildcards can help.  
 

 
Figure 33 Add Part Command 
 

 
Figure 34 Add Part Menu 



 
Figure 35 Libraries Control Panel 
 
 
 
For our simple synth project, the first thing we need is the Hex Schmitt Trigger we used in our 
Fritzing tutorial. If you type 4584—which is one of the names the chip goes by—nothing will 
show up. It will say on the right “Sorry, no match!” (figure 36). But if you search for “4584?” the 
part will show up because there are two flavors of the same chip each with a different character 
at the end: D for small outline (SO) package and N for dual in-line (DIL) package (figure 37).  
Entering “Hex Schmitt Trigger” will reveal more than one part, “74C14” will have the same 
result as “4584?”, and searching “74*” or “45*” returns long lists (figure 38).  
 

 
Figure 36 Sorry no match 



 
Figure 37 ? Wildcard 
 

 
Figure 38 * Wildcard 
 
 
 
The Hex Schmitt Trigger has six inverters on a single chip. When you select the part from the 
library it will give you the first inverter of the chip (Figure 39), but as you keep stamping the part 
across the schematic sheet, each iteration will consist of a new stage, respectively labeled IC1A, 
IC1B, IC1C and so on, until all six have been used up; stamp some more and Eagle will add a 
second chip, and you will see IC2A, IC2B, etc. (Figure 40). 
  



 
Figure 39 A single inverter 
 

 
Figure 40 All inverters 
 
Start by adding power and ground as we did with Fritzing. These will be found on the supply1 
and supply2 libraries. Select VCC (+ V) and GND from either supply1 or supply2 (Figure 41, 
42, 43). As long as they have the same name, power and ground busses are always connected and 
therefore do not need to be physically connected together in the schematic. Copying and pasting 
VCC and GND wherever necessary is enough. But, where and how do we connect them? As you 
have probably noticed already, the power and ground pins of the Hex Schmitt Trigger (7 and 14 
respectively) are not available even after you have pasted all six inverter sections. We need to 
ask for them which we do by right clicking on the little cross at the center of the chip—that is the 
part origin—and selecting “Invoke” (Figure 44). A pop-up window will show a list, at the 



bottom of which you will see “P PMRN request 0” (Figure 45).  Select it and click OK. Two new 
pins appear, which you can place on top of the part using the origin for reference (Figure 46, 47). 
By default, the top one will be + power and the bottom one ground. To make connections in the 
schematic editor, select in the toolbar a green L shaped symbol called Net (Figure 48). Once 
selected, whenever a connection can be made, a hollow green circle will appear when hovering 
the cursor. Arrange the parts as you see fit in the sheet and make the connections (Figure 40). 
Resistors, capacitors and inductors are found on a library called “rcl” (Figure 50, 51, 52).  For 
power connect a 9v battery clip to the wire pads (Figure 53). Then add an audio jack (figure 54, 
55, 56, 57, 58, 59).  
 

 
Figure 41 VCC 
 

 
Figure 42 GND 
 



 
Figure 43 VCC & GND in Schematic 
 

 
Figure 44 Invoke 



 
Figure 45 Invoke Box 
 

 
Figure 46 VCC & GND Pins 
 



 
Figure 47 VCC & GND Pins 
 

 
Figure 48 Net Command 
 



 
Figure 49 PWR pins connected 
 

 
Figure 50 Rcl Library 
 



 
Figure 51 Capacitor 
 

 
Figure 52 Resistor & Capacitor 
 



 
Figure 53 Wirepads 
 

 
Figure 54 Audio Jack 
 



 
Figure 55 Audio Jack in Schematic view 
 

 
Figure 56 Audio Jack Pins 
 



 
Figure 56.1 Audio Jack Pins 
 

 
Figure 57 Tip - Audio Jack Pins 
 



 
Figure 58 Sleeve - Audio Jack Pins 
 

 
Figure 59 Audio Jack Connected 
 
 
Board Layout 
 
Now that the schematic is done, it’s time to work on the board layout. At the top of the editor, to 
the right of the Print icon, there is a gray and green square that reads SCH BRD. Click it. It will 
prompt a message saying that the board does not exist and ask whether it should be created 



(figure 60). Click “Yes” and the board layout editor will open. On this editor many new features 
are introduced. New items have been added to the toolbar on the left and others are no longer 
available. Next to it is the Design Manager (figure 61), which is a powerful tool that will help 
monitor and properly manage the board layout. If it is not there by default, open it through the 
View tab on top. 
 

 
Figure 60 Create from Schematic 
 

 
Figure 61 Design Manager 
 



 
Unlike working with the schematic, in the board editor the grid can be changed as needed. It will 
default to twentieths of an inch, but any desired measurement can be used. Even though the pins 
of the integrated circuit we are using are spaced at a tenth of an inch from one another, the 
components that connect to them can be freely placed around it. Turn On the display and adjust 
the grid to your preference. Additionally, if you go Options > User Interface, you can change 
your cursor from Small to Large (figure. 61.1). This is optional but I think the larger cursor is 
useful for arranging parts on the board. (This feature is also available for the Schematic view.) 
 

 
Figure 61.1 Cursor large 
 
As mentioned before, both editors on Eagle are synchronized. Eagle keeps track of what happens 
in one editor and translates that into the other immediately. Closing one editor and working on 
the other will disturb that synchronization, and not only is the project’s health at a high risk but 
trying to undo changes is the thing of nightmares. That is why, when an editor is closed, Eagle 
will let you know that synchronization has been lost with a yellow and black warning ribbon 
(figure 62). 



 
Figure 62 Sync warning 
 
A very important part of both editors is the Layer Settings (figure 63, 64). When working in the 
board layout, this feature will acquire particular prominence as the different components are 
distributed across the board. Access to the Layer Settings is available through the toolbar by 
clicking on the stacked-up rectangles above the Move command. All layers will be listed on this 
menu. Visible ones will have an eye on the left. PCBs usually consist of a substrate (such as 
fiberglass) with copper, soldermask and silkscreen layers on each side. On Eagle, the Top copper 
layer is red and the Bottom copper layer is blue (unlike Fritzing which is yellow and orange 
respectively); Pads and Vias are green; Dimension, which is the board outline, is mustard yellow; 
and other layers such as the Drills are gray. You will probably memorize this as you work. If 
some work needed to be done on a particular set of layers, here is where they are managed.  
 

 
Figure 63 Layer Settings 



 
Figure 64 Layer Settings Menu 
 
 
To keep things simple, we will design a single-sided board. This means that all parts will be 
placed on the top and all traces will be on the bottom (like when using a generic proto-board). 
Even though circuits done in this chapter are quite simple, you can do a double-sided board if 
you wanted to. But if you are milling the board yourself I would recommend sticking to single-
sided for now (see “Milling PCBs” below).  
 
All the parts of the design will be placed at the bottom-left of the workspace (figure 65). The 
black rectangle with yellow borders is the board. It can be modified as the design is being 
worked. Using the Group tool, move everything onto the board (figure 66, 67). There are yellow 
lines connecting the parts. These are not traces on the board but “airwires”, and they show how 
everything is connected. Start by arranging the parts however you please on the board. Use the 
airwires as a reference on how to distribute the parts. Clicking the Ratsnest button (figure 68) 
will recalculate airwires -- it looks like an X made with five circles and is located below the 
Polygon command (which looks like a pentagon). If airwires bother you, open the Layers menu 
and deselect the Unrouted layer. Start by placing the chip, which is the most complex part, and 
then add supply, resistors, capacitors, diodes and jumpers (figure 69).  
 

 
Figure 65 Parts at the bottom-left 



 
Figure 66 Group Tool 
 

 
Figure 67 Group Tool Select 
 



 
Figure 68 Ratsnest 
 

 
Figure 69 Parts arranged 
 
 
To make the traces we use the Route command (figure 70). In the toolbar it is the one right 
below the Rotate command, represented by two green dots connected by a blue trace. An arrow 
pointing downwards on the Route icon accesses a few additional modes of this command (such 
as Quick Route Signal). Route Airwire should suffice for now, but if you are feeling curious try 
the other modes and see what they do. Above the workspace and the command line are 



additional important settings for this tool. Start by selecting “16 Bottom” on the Layer drop-
down menu since we will be making a single-sided board with all the traces at the bottom. Right 
next to that are some routing behavior settings. “Walkaround Obstacles” will be selected by 
default and that is good. On the Width menu, since it is a simple circuit, you can go with nice 
thick traces—0.024 or 0.032 are good values. Thicker traces are preferred when milling your 
board since thin ones peel off easier. For a single-sided board don’t worry about Vias shape or 
Drill size. For double-sided boards, round shape and auto Diameter should be alright.   Make 
sure that Drill size is at least c. 0.02; the default value is probably alright, but I would 
recommend checking the board house specs (more on this later). For the Wire Bend, experiment 
as you go.  
 

 
Figure 70 Route 
 
 
To route a trace just click at one end of an airwire and complete the connection to the other end 
(figure 71, 71.1). As traces are being made the Route command will make suggestions on how to 
proceed. Clicking along the way creates fixed joints around which the traces will pivot. Once a 
trace is finished Eagle will make a sound and the name of the signal will be assigned to it.  Vias 
allows you to move a signal from one side of a double-sided board to the other: simply press 
down your mouse’s scroll wheel or middle button, or manually change the layer and for the next 
trace a Vias will be on your cursor. To delete a trace just use the Ripup command (figure 72), to 
the right of Route on the toolbar, with a little red X. Play with the Route tool. Try different trace 
widths, try drawing shapes, see what kind of narratives can be told, explore how different 
arrangements of parts and traces affect the overall functionality of your design. 
  



 
Figure 71 Making traces 
 

 
Figure 71.1 All traces 
 



 
Figure 72 Ripup 
 
 
Another way to proceed is using the Autorouter. In the Toolbar it looks like the Route command 
but with a little lightning bolt. Do not think of this as an easy way out but as a different approach 
to problem solving. Similar to Fritzing, it is highly unlikely that the solution that the Autorouter 
will come up with will be the best option – lots of editing afterwards. When selected it will 
prompt a Setup menu (figure 73). Try the default settings (if it is a single-sided board leave just 
the Bottom in Auto and select N/A for the Top) and press Continue. A Routing Variants window 
will appear, press Start. Once it is done, select one of the alternatives it came up with and press 
End Job. Now patiently edit the traces to fit your design’s needs.  
 

 
Figure 73 Autorouter 



 
 
Fortunately, when routing one trace at a time, or editing the Autorouter’s traces, there is a way to 
make sure everything is correct: the Design Rule Check (figure 74). You will find it either under 
the Tools tab in the menu bar as DRC, or in the Toolbar when expanded using the double arrow 
at the bottom. The DRC will let you know whether your design meets specific manufacturing 
requirements. When opened, a setup window will appear with multiple tabs, each storing the 
default values for various important aspects of your design, such as the minimum distance 
between objects, minimum drills and width, etc. After you are done making traces go ahead and 
do a check with the default values. If there are any issues a DRC Errors pop-up window will 
appear (figure 75). For example, if some connection has been left unrouted, it will appear as an 
Airwire under Errors. If you select a specific error in the menu, Eagle will indicate where it is in 
your Board Layout. If there are no errors (wheee!) you will see in the bottom left corner a 
message that reads “DRC: No errors.” You can also load third party design rules with .dru files.  
 

 
Figure 74 DRC 
 

 
Figure 75 DRC Error 



 
It is common practice to do a “copper pour” at some point when doing your board layout. A 
copper pour is when an “open” part of the board is filled with copper and connections are made 
to it. The most common use is as a ground plane, which reduces noise in circuits. Some do it at 
the beginning to simplify what could otherwise be a complex design to route, and others do it at 
the end as nice finishing touch with practical benefits. It is not obligatory, yet it does not hurt to 
do so, therefore it is up to you. Copper pour in Eagle are easy.  Select the Polygon tool (figure 
76) and draw your board’s outline on the desired layer, either Top or Bottom (figure 77). Once 
you have completed the shape, a dialog box will ask you to enter the signal’s name, which is 
usually ground, named GND or something similar (figure 78). If you are not sure, check with the 
Design Manager. Once you have entered the signal the polygon’s outline will be dashed (figure 
79). If it never asked for a final name to be entered, use the Name command that’s between the 
Design Block and Copy commands, as “R2 /10k” (hover your cursor on top of it and it should 
say “Name”) (figure 80). Click the polygon outline, enter the name and select the “this Polygon” 
option (figure 81). To finish select the Ratsnest command and copper should cover the entirety of 
the “open” board surface, avoiding all traces other than GND (figure 82). All GND traces now 
connect to this plane and every other path should have the minimum clearance from it. 
Depending of what your design is, doing ground pours can be essential for things such as 
decoupling. But there is occasionally great joy in making circuits misbehave, so it is up to you 
how you use it.  
 

 
Figure 76 Polygon Tool 
 



 
Figure 77 Polygon 
 

 
Figure 78 Signal Name Polygon 
 



 
Figure 79 Dashed Polygon 
 

 
Figure 80 Name Command 
 



 
Figure 81 This Polygon 
 

 
Figure 82 Copper Pour 
 
 
Making boards 
 
It’s good practice to print your board layout on paper once it is done, glue it on a styrofoam 
block, and do a mock-up version of the circuit to make sure that the parts are correct and that the 
spacings are adequate (thank you Robert Drinkwater!). It is no fun to find yourself fixing every 
hole on the board with a pin vise because they were too small; or learning that the legs of your 



switch do not match the part that was used as a template for the design. If everything fits alright 
on paper, then we can fabricate a prototype.  
 
There are three option when it comes to making your own boards: etching, milling and 
manufacture. Etching will not be covered on this chapter – despite its old-school cred (think 
Robert Moog’s 1950s Theremin kits) -- because improperly disposed ferric oxide will not only 
ruin your sink and plumbing, but is also a serious environmental hazard and is illegal to throw 
out. The other two approaches are safer.  
 
Milling PCBs 
 
Milling boards is a fast and reliable way of prototyping your designs before manufacturing them 
by the hundreds through a commercial house. It can be sufficient to produce a handful of boards 
for yourself and your friends. For this example, I will focus on Bantam Tools Desktop PCB 
Milling Machine, a CNC machine.  Although at the time of writing still a little pricey for the 
amateur hacker, they are popping up in art schools and maker spaces. Ask around, but if for any 
reason milling is not an option, jump ahead to the next section on board houses.  
 
The first thing to do is download Bantam’s milling machine software to communicate with the 
mill and setup your project. You find it at bantamtools.com/software-download. Install the 
application and launch it. The software is simple and fairly intuitive. In the center of your 
computer screen you should see the bed of the machine and a blue block, which is your generic 
material (figure 83). Zooming out enough will reveal an opaque image of the mill (figure 84). 
Above, different views are available: front, top and 3D; as well as preview and toolpath options. 
On the right are the configuration settings for your project. Connect the mill to your computer. 
Locate the bed.  
 

 
Figure 83 Bantam Material 



 
Figure 84 Bantam Machine 
 
Printed circuit boards are made of different materials. FR-4, made of fiberglass and epoxy resin, 
is probably the most common, but because of the fiberglass, machining FR-4 is dangerous for 
your health. Instead we are going to use FR-1, made with phenolic resin, which is safer (but 
nonetheless avoid ingesting, inhaling or getting it in your eyes). FR-1 can be acquired from many 
sources, including Bantam but also SparkFun and Digi-Key. On Bantam’s Material dropdown 
menu select Single-Sided FR-1.  On the Material dropdown menu select Single-Sided FR1. 
Immediately the generic blue block turns into a copper board. If the board you have has different 
measurements, adjust the width and the height on the Size menu. I recommend leaving the 
default value thickness. Using thin double-sided tape, place your board on the mill’s bed and 
against the guides. The tape is just so that the board is stable while the machines works. Do no 
use anything thicker than scotch tape.  
 
Import your design from your EDA (Fritzing, Eagle, etc.) into Bantam by clicking on the open 
button on the Plans section. Bantam supports many different file formats but we will use “.brd.” 
The design layout will appear on the board and can be moved within the boundaries. Use the 
placement menu to indicate the location and orientation.  Leave small distance between the 
design and the guides for the safety of the drill bit.  
 
In Milling Tools select the sizes of the bits that you will be using. If two traces are too close for 
the bit diameter, red marks will show on the design. You can try different milling tools, or the 



traces can be adjusted in Eagle and refreshed on Bantam so that the changes are reflected. 
Whenever possible use just one tool for the whole job, it’s easier. Below the Start Milling button 
is an estimate of how much time will it take to mill the board. Under Advance, both the depth 
and clearance of the traces can be adjusted. Remember that milling too deep may result in a 
fragile board and also the bit will become dull faster. Too much clearance will increase the 
turnaround time considerably, and also will make the bit dull faster.  
 
Once your setup is ready click Mill All Visible. The machine will ask for you to insert the new 
tool. After tool is in place the mill “locates” the tool by touching the bed. Then milling starts.  
 
When the board is ready, carefully—you don’t want to snap it—lift it off the bed. Before 
soldering the components in place, take the time to check and clean the board. Make sure that 
there is no copper residue shorting the circuit.  
 
Assemble the board carefully. FR1 boards will allow for maybe one soldering mistake before the 
copper burns or peels off.  
 
Manufacturing 
 
Getting a board design manufactured requires that the files are submitted that comply with the 
board house’s specifications. There are hundreds of manufacturers, and although the process is 
fairly standardized, requirements often differ from one to another. Failing to adhere to the 
appropriate spec may result in mistakes, or the board not being produced at all. Eagle makes it 
very easy to generate the necessary manufacturing files. These are Gerber (.gbr) files which 
include copper, soldermask and silkscreen, among other layers; and Excellon (.xln) for your drill 
files.  
 
Some manufacturers, such as OSH Park, accept Eagle’s .brd files so you don’t need to generate 
additional files. Nonetheless, you should import their Design Rule files and check your design.  
Go to docs.oshpark.com/design-tools/eagle/design-rules-files/ and download the .dru file for 
either 2 or 4-layer boards. Then, on Eagle, go to Tools > DRC > Load and select the .dru file that 
you just downloaded for your project. Now when you do a Design Rules Check, Eagle will use 
OSH Park’s specifications. 
 
You might work with various board houses, so knowing how to produce the necessary files is 
important. First, open up the CAM processor, which is at the top on the board editor and looks 
like a factory with three windows (figure 85). CAM stands for computer-aided manufacturing.   
This new menu is divided into a few different parts (figure 86). On the upper-left corner a bar 
will tell what kind of CAM job will be produced. The default for our version of Eagle is a 2-layer 
template. If you click on the paper sheet icon next to it, a drop-down menu will offer additional 
options (figure 87). 
  



 
Figure 85 Eagle CAM Processor 
 

 
Figure 86 Menu CAM Processor 
 



 
Figure 87 CAM Job Templates 
 
On the left the Output Files section lists all the different types of files and their contents. For 
example, when one of the Gerber files is selected, its contents will be made visible as a list in the 
Layers panel, along with a graphic representation of those layers (figure 88). Two check-boxes 
for board shape and cutouts are available to include on each of the files. These can prove useful 
for aligning and assembly, but check with your board house specs if it is necessary to do so.  
 

 
Figure 88 Output Files 
 
 



Before exporting anything click on “Gerber” in the Output Files section, and on Options the 
default should be either Gerber RS-274X or the newer format Gerber X2. Gerber X2 is 
backwards compatible and will work with any board manufacturer. All files will be exported 
when Process Job is clicked. Individual files can be obtained by using the Output bar below the 
Layers section: select the layer you want and click Export File.  
 
A good way to start production is to use the third-party CAM job files included with Eagle. Press 
Load Job File—which is the paper sheet icon with an arrow pointing to the right—then at the 
bottom select System Examples > Third Party and in there you will find Seeed, OSH Park, Aisler 
and Beta Layout CAM job files for 2, 4 and even 6-layer boards. All these manufacturers offer 
professional PCB services for reasonable prices and a prompt turnaround. There is no need to 
produce 100 boards of a design that has not been tested out. An order can be placed with OSH 
Park—for example—for as little as 3 boards. This way economic risk—and e-waste—is reduced 
significantly when a project is still in its development phase. Eagle is not the only EDA that 
offers CAM templates. Fritzing is also affiliated with Aisler, or you can ask your board house of 
preference whether they have .dru file and/or CAM Job templates. There are manufacturers all 
over the world and there is no need to stick to these specifically. If another PCB manufacturer is 
particularly convenient because of location or any other reason, contact them and request their 
specifications. Once everything’s setup the way you want it on the CAM Processor, click Process 
Job (figure 89, 90) and all the files will be saved in a .zip file ready to be sent to the board house.  
 

 
Figure 89 Process Job 
 



 
Figure 90 CAM Job Successful 
 
 
Going forward, a good thing to explore is how to make new parts in Eagle. This is not difficult. 
You can start by duplicating and modifying an already existing part to suit your needs. Parts are 
made of a symbol and a package, they meet to form a device that lives in your parts library. You 
can find many step-by-step guides with a quick search online. Understanding how parts are made 
can shed some additional light on the best way to develop your designs, and which parts to 
choose from the vast libraries. Unlike Fritzing, Eagle doesn’t have a Breadboard view. But 
because there are 3D models of many of the parts in the library, a design can be imported into 
Fusion 360 to do further work on it.  
 


